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Overview
Password Keeper for Windows 95/NT is a small utility for storing your frequently used passwords. Password information can be 
stored, edited and printed with this easy to use program. 

Each password file that you create can contain up to 1000 account entries. You will never forget a password again with this 
handy utility installed on your Windows 95/NT system. Password Keeper includes a facility to optionally generate random 
alphanumeric passwords automatically. These passwords will be difficult for others to guess.

Password Keeper data files are stored in an encrypted format to prevent unauthorized users from accessing and viewing them. 
Passwords can be copied to the Clipboard and pasted into other login programs.

Please remember the file access password you assign to your Password Keeper document. This password is used to encrypt 
the actual account records stored in the document. Without this password you will not be able to access the documents you 
create. There is no way to recover the account record data without this password, so please remember the password you 
assign.

Other Uses
Password Keeper can also be used to store PIN numbers and safe combinations. Any private access information that needs to 
be saved in a secure location can be stored in Password Keepers files.

Web Site URL Addresses
Password Keeper can also be used store a web site address for each account record. You can use Password Keeper to 
automatically launch your web browser and go directly to a web site on the Internet.

Purchasing
Password Keeper for Windows 95/NT is a fully functioning program, it is not time-limited or crippled in any way.

Password Keeper for Windows 95/NT is distributed as shareware. You may evaluate it free of charge for 30 days. After 30 days 
if you continue to use Password Keeper for Windows 95/NT you are required to register it. If after evaluating Password Keeper 
for 30 days you decide not to register it you are required to remove it from your computer.

Registration entitles you to unlimited free updates and support via E-Mail or telephone.

Desktop Locations
Password Keeper’s location on the desktop is saved when the program is exited. Whenever you start Password Keeper it will 
reappear on the desktop where you last placed it. Password Keeper property sheet locations are also stored and reused the 
next time they are opened.

Taskbar Tray
Password Keeper for Windows 95/NT can be optionally configured to place its program icon in the Taskbar Icon Notification Tray.
This option provides a simple means of keeping the taskbar button region clear for other running programs.



Installing Password Keeper
Installation
To install Password Keeper for Windows 95/NT on your computer simply create a new, empty folder and place the files; 
PASSKEEP.EXE, PASSKEEP.HLP and PASSKEEP.CNT there.

PASSKEEP.EXE - The Password Keeper Application
PASSKEEP.HLP - The Windows 95/NT Help File
PASSKEEP.CNT - The Help Contents File

If you use the SETUP.EXE program and specify the default installation directory Password Keeper will be copied to the C:\
Program Files\Software by Design folder.

To integrate Password Keeper for Windows 95/NT with the MS Windows Explorer select the Password Keeper Explorer Setup 
property sheet while Password Keeper is running.

Note If you have an earlier version of Password Keeper for Windows 95/NT installed on your computer, simply replace the 
PASSKEEP.EXE, PASSKEEP.HLP and PASSKEEP.CNT files with the newer versions. Password Keeper stores configuration 
information in the MS Windows 95/NT System Registry.

Note The PASSKEEP.INI file is no longer used and can be deleted. The various application settings specified in the Password 
Keeper Options property sheet as well as the main window’s size and location on the desktop are now stored in the MS 
Windows 95/NT System Registry.

Note Some earlier versions of Password Keeper for Windows 95/NT included a PASSKEEP.WRI documentation file. This file 
has been replaced by the PASSKEEP.HLP file and can now be deleted.

Warning If you rename the PASSKEEP.EXE file you must also rename the HLP file using the same basename. For example if 
you change the Password Keeper application file name to NewName.exe, rename the help file to NewName.hlp as well. The 
HLP file must reside in the same folder as the Password Keeper application file itself.



Configuring Password Keeper
Password Keeper Options
Select the File | Options menu item to display the Password Keeper Options property sheet. This window will allow you to 
change the various Password Keeper program settings listed below.

Place Icon in the Taskbar Tray
Check this item to display a small Password Keeper program icon in the Taskbar Icon Notification Tray. If this item is selected 
and the Password Keeper window is minimized a button will not be added to the Taskbar, to restore the Password Keeper 
window on the desktop press the small icon in the taskbar tray instead. This option is available to keep the taskbar free for 
other running programs.

Note When this option is selected, clicking on the Close box in the upper-right hand corner of the window title bar will 
minimize Password Keeper instead of closing the application. To quit Password Keeper right-click with your mouse on the 
Password Keeper icon in the Taskbar tray. You may also use the File | Exit menu command or the Ctrl+Q keyboard shortcut.

Minimize Program Icon at Startup
Check this item to minimize the main window on the Taskbar or Icon tray when Password Keeper is first started.

Confirm Program Exit
Check this item to confirm quitting Password Keeper for Windows 95/NT. When this option is selected you will be prompted to 
confirm your intention to exit Password Keeper and return to the MS Explorer desktop. This item is useful if you run Password 
Keeper from the tray and wish to avoid accidental exits when you right-click on the Password Keeper tray icon.

Show Tool Bar Tips
Check this item to display small popup tip windows when the mouse pointer is placed over toolbar ribbon pushbuttons. A short
description of the button currently beneath the mouse will be shown when this item is checked.

Dark Window Backgrounds
Check this item to display the text in list windows with a dark background instead of the paper white background MS Windows
normally uses when displaying text.

Reopen the Last File Used at Startup
Check this box to reopen the last password file used when Password Keeper is launched.

Save Changes Automatically
Check this box to automatically save editing changes when a password document is closed. If this box is not checked you will 
be prompted before closing documents that have changed.

Sounds with Warning Dialog Boxes
Check this box to play a short beep sound when Password Keeper displays a warning dialog box or an error occurs.

OK
Press this button when you have completed your selection of Password Keeper program options. When you press this button 
the Password Keeper Options property sheet will be closed and your settings will be saved.

Cancel
Press this button to close the Password Keeper Options property sheet without making any changes. If you have made any 
changes to the option settings, and then press this button your changes will not be used, and your previous settings will 
remain in use.

Help
Press this button to open the Password Keeper Help Window and go directly to the Configuring Password Keeper topic.

Note The options you have selected will be saved when you press the OK button. The desktop location of the Password Keeper
Options window itself will also be stored.



Password Keeper Security Settings
Password Keeper Security Settings
Select the File | Options menu item to display the Password Keeper Options property sheet, then select the Security tab. This 
window will allow you to change the various Password Keeper security settings listed below.

Time Period to Display Account Password
Specify the time period to display account password information before hiding the selected entry again. The time period to 
display a password can be between 1 and 120 seconds (2 minutes).

Minimize Windows on Display Timeout
Check this item to minimize the Password Keeper main window to an icon on the Taskbar or Notification Tray when the 
display period defined above has elapsed.

Always Show Information
Check this item to show the selected account password indefinitely, instead of hiding it after a short display period.

Length for Randomly Generated Passwords
Enter the length to be used when generating random account passwords. The password length you specify can be between 4
and 46 characters. This value will be used when random alphanumeric passwords are generated.

Display Password with Account Record
Check this item to show the currently selected account record password. If this item is unchecked the password for the 
currently selected account record will be replaced with a ‘********’ hidden text string.

Note The password associated with the currently selected account record will still be available for Copy / Paste operations 
into other login programs, but will not appear in the Password Keeper window if the option above is left unchecked.

OK
Press this button when you have completed your selection of Password Keeper program options. When you press this button 
the Password Keeper Options property sheet will be closed and your settings will be saved.

Cancel
Press this button to close the Password Keeper Options property sheet without making any changes. If you have made any 
changes to the option settings, and then press this button your changes will not be used, and your previous settings will 
remain in use.

Help
Press this button to open the Password Keeper Help Window and go directly to the Password Keeper Security Settings topic.

Note The options you have selected will be saved when you press the OK button. The desktop location of the Password Keeper
Options window itself will also be stored.



Password Keeper Page Setup
Password Keeper Page Setup
Password Keeper can be configured to use custom headers and footers when printing Password Keeper documents using the 
File | Page Setup menu item.

Password Keeper File Information Macros
Displayed below is a list of Password Keeper File Information Macros available for inclusion in custom headers and footers.

$F = File Name The current document name with full drive and path will be inserted at the point where the $F 
macro appears

$f = File Name The current document name without a drive or path will be inserted at the point where the $f 
macro appears

$P = Page Number The current page number will be inserted at the point where the $P macro appears

$T = Current Time The current time will be inserted at the point the $T macro appears

$D = Current Date The current date in long format will be inserted at the point the $D macro appears

$d = Current Date The current date in short format will be inserted at the point the $d macro appears

Any other text specified in a header or footer will be treated as literal and will appear just as defined. To include the actual ‘$’ 
character in a header or footer use ‘$$’.

Header
Define the header text you wish to have appear at the top of each page printed. See the File Information Macros section 
above for a complete description of those items that can automatically be included in a header.

Print Header
Check this item to enable the header defined above. If this item is not checked the header you defined above will not be 
printed. This item is included to facilitate turning header printing on and off with out deleting the header you have defined

Center Header
Check this item to center the header at the top of each printed page. If this item is not checked the header you have defined 
above will be printed starting at the left margin.

Footer
Define the footer text you wish to have appear at the bottom of each page printed. See the File Information Macros section 
above for a complete description of those items that can automatically be included in a footer.

Print Footer
Check this item to enable the footer defined above. If this item is not checked the footer you defined above will not be printed. 
This item is included to facilitate turning footer printing on and off with out deleting the footer you have defined

Center Footer
Check this item to center the footer at the bottom of each printed page. If this item is not checked the footer you have defined 
above will be printed starting at the left margin.

Printer Page Margins
Use the following four entry fields to specify the page margins to be used when printing documents. Margin widths are 
expressed in decimal inches, for example 1.25, 0.50, .25 or 1 are all valid margin widths.

Left
Enter the left margin width in this field. Document text will be printed starting from this position on the left side on the page.

Right
Enter the right margin width in this field. Document text will be printed across the page to this position.

Top
Enter the top margin width in this field. Document text will be printed starting from this position at the top of the page.

Bottom
Enter the bottom margin width in this field. Document text will be printed down to this position at the bottom of the page.

Note If you have defined a header or footer to be printed on each page make certain that you set the top and bottom margin 
widths to at least 0.10 inches or your document text will be printed directly on top of the headers and footers you defined.



OK
Press this button when you have completed your selection of Page Setup settings. When you press this button the Page 
Setup property sheet will be closed and your settings will be saved.

Cancel
Press this button to close the Page Setup property sheet without making any changes. If you have made any changes to the 
Page Setup settings, and then press this button your changes will not be used, and your previous settings will remain in use.

Help
Press this button to open the Password Keeper Help window and go directly to the Password Keeper Page Setup topic.

Note The Page Setup settings you have selected will be saved when you press the OK button. The desktop location of the Page
Setup window itself will also be stored. Your Page Setup settings will be saved in the MS Windows 95/NT System Registry.



Password Keeper Explorer Setup
Password Keeper Explorer Setup
Select the Help | Setup menu item to display the Password Keeper Explorer Setup property sheet. This window will allow you to
integrate Password Keeper for Windows 95/NT with the Microsoft Windows 95/NT Explorer. Use this command to create and 
remove MS Explorer shortcuts.

Create a Start Menu Item
Check this item to create a Password Keeper Start Menu entry. The Password Keeper for Windows 95/NT program will be 
located in the Software by Design folder on the Programs menu. This item will be disabled (grayed) if a Password Keeper item
already exists in the Software by Design folder.

Remove this Start Menu Item
Check this item to remove the Password Keeper entry located in the Software by Design folder on the Programs menu. This 
item will be disabled (grayed) if a Password Keeper item does not already exist in the Software by Design folder.

Create a Desktop Icon
Check this item to create a Password Keeper for Windows 95/NT program icon on the Explorer desktop. This item will be 
disabled (grayed) if a Password Keeper desktop icon already exists.

Remove Icon from the Desktop
Check this item to remove the Password Keeper for Windows 95/NT program icon from the Explorer desktop. This item will be
disabled (grayed) if a Password Keeper desktop icon does not already exist.

Create a Startup Folder Item
Check this item to automatically run Password Keeper for Windows 95/NT whenever Microsoft Windows is started. This 
option creates a Password Keeper program icon in the MS Windows Explorer Startup folder. This item will be disabled 
(grayed) if a Password Keeper startup item already exists in the Startup folder.

Remove the Startup Folder Item
Check this item to remove Password Keeper from the MS Windows Explorer Startup folder. This item will be disabled (grayed)
if a Password Keeper startup item does not already exist in the Startup folder.

OK
Press this button when you have completed your selection of MS Explorer shortcuts. When you press this button the 
Password Keeper Explorer Setup property sheet will be closed and the MS Explorer shortcuts you have selected will be 
created or removed.

Cancel
Press this button to close the Password Keeper Explorer Setup property sheet without creating or removing any MS Explorer 
shortcuts.

Help
Press this button to open the Password Keeper Help window and go directly to the Password Keeper Explorer Setup topic.



Editing Account Entries
Editing Account Entries
Password Keeper account entries are easily created and edited using the Editor window. Select Edit | Add Account or Edit | 
Edit Account to display the Password Keeper Account Editing window.

When either of these commands is selected a property sheet will be displayed. Use this property sheet to create new account 
entries or edit existing records. The entry fields available are described below.

Account Name
Use this field to store the account name for this Password Keeper database entry. This field will normally be filled with the 
name of the account this password record is used with, for example America Online, or CompuServe. This field must be filled.

Login Name
Use this field to record your login name for this account. This will normally be your user name for this login account.

Password
Use this field to store your login access password for this account. Press the [...] button to the right of this entry field to have 
Password Keeper generate a random alphanumeric password entry for you automatically. This facility is useful if you would 
like to create a password that will be difficult for others to guess.

Web Site URL
Use this field to store an optional web site URL address for this account. If this field is filled you can use the Visit URL 
command to automatically launch your web browser and go directly to the web site on the internet.

Note If the current account record includes a password it will be copied to the Clipboard prior to launching your web browser.

Notes and Comments
Use this entry field to store any notes or comments you would like to record for this account record.

OK
Press this button when you have completed editing the current Password Keeper account entry. When you press this button 
the Password Keeper Account Editing window will be closed and your changes will be saved.

Cancel
Press this button to close the Password Keeper Account Editing windows without making any changes. If you have made any 
changes to the account record, and then press this button your changes will not be saved, and your previous entries will 
remain unchanged.

Help
Press this button to open the Password Keeper Help Window and go directly to the Editing Account Entries topic.



File Access Password
File Access Password
Please remember the file access password you use for your Password Keeper document files, this is the password you 
assigned when you created your Password Keeper file. This password key is used to encrypt the document file itself, without this
password you will not be able to access the documents you create or the account records that they contain.

Note Password Keeper file access passwords are case sensitive, so always enter the file access password exactly as you 
originally assigned it.



File Menu
File Menu Commands
The File menu provides commands to work with the document files used by Password Keeper. A short description of each item 
follows:

New
Creates a new Password Keeper document. You will be prompted to assign a document access password to the file you 
are creating. The Ctrl+N shortcut can be used for this command.

Open
Opens an existing Password Keeper document, and loads it for editing or viewing. When this item is selected the standard 
MS Windows Explorer file browser will be displayed, use this window to select the document you wish to work with. Check 
the Open as Read-Only box to load documents for viewing only. You will be prompted to enter the document access 
password for the file you select. This is the password you assigned to the file when it was created. The Ctrl+O shortcut can
be used for this command.

Properties
Displays a small window showing file properties for the currently selected Password Keeper document. This window will 
display the document’s file name, folder location, size, last modification date and file access permissions. The Alt+Enter 
shortcut can be used for this command.

Close
Closes the currently active document. If the document has been edited you will be prompted to save or discard the changes
before closing. The Ctrl+W shortcut can be used for this command.

Save
Saves changes made to the currently selected document. This menu will be disabled (grayed) if no changes have been 
made to the document since it was last loaded or saved. The Ctrl+S shortcut can be used for this command.

Save As
Saves the currently active document with a new name. When this item is selected the standard MS Windows Explorer file 
browser will be displayed, use this window to specify a new name for the document. You will be prompted to assign a new 
password and verify it before the file is saved with the new name and access password you have selected.

Page Setup
Opens the Page Setup property sheet and allows you to change Password Keeper printer page layout settings.

Printer Setup
This command allows you to select a printer and set various printer options using the standard MS Windows 95/NT Printer 
Setup dialog box.

Tip Use this command to quickly select the Landscape mode for printing Password Keeper account lists.

Printer Font
This command allows you to select a font for printing using the standard MS Windows 95/NT Font dialog box.

Tip Select a small 7 or 8 pt. font for printed Password Keeper account lists. You might also want to try using Microsoft 
Small Fonts at 6 or 7 pt. to display account lists with long web site URL addresses.

Print
Prints the currently selected Password Keeper document on your system’s printer. A dialog box will appear before printing 
is started to allow you to select the printer to be used and various other printer options. The Ctrl+P shortcut can be used for
this command.

Tip Set your printer to the Landscape mode when printing Password Keeper documents.

File Password
This command allows you to change the document access password for the file currently being edited. You will be 
prompted to enter the current document access password assigned to the file as well as the new password you wish to 
assign to it. You will be required to type the new password assignment a second time to verify the entry. This item will be 
disabled (grayed) if the current file has been modified and not saved yet, or the file was opened for viewing as read-only.

Options
Opens the Password Keeper Options property sheet and allows you to change Password Keeper program settings. Use 
this command to configure the Password Keeper program.

Exit
Closes the Password Keeper program and returns control to the Explorer desktop. The Ctrl+Q shortcut can be used for this



command.

Tip Commonly used File commands can be invoked using shortcut keys or buttons on the toolbar ribbon.



Edit Menu
Edit Menu Commands
The Edit menu provides commands used to edit the contents of Password Keeper documents. A short description of each item 
follows:

Copy Login Password
Copies the current account selection’s password to the Clipboard. You can then paste this information into your login 
program. The Ctrl+L shortcut can be used for this command.

Note The Copy command will still copy the password to the Clipboard even if the Display Password with Account option is 
unchecked.

Add Account
Use this command to add a new password account record to the current document. The Ctrl+A shortcut can be used for 
this command.

Edit Account
Use this command to edit the currently selected password account record. You will be able to change the account name, 
login ID, password and notes specific to the currently selected record. The Ctrl+E shortcut can be used for this command.

Delete
Deletes the currently selected account record. You will be prompted to confirm the record you wish to delete. The Del 
shortcut can be used for this command.

Read Only
Turns editing permission on and off. If this item is checked the current document can be viewed but editing will not be 
allowed.

Tip Commonly used Edit commands can be invoked using shortcut keys or buttons on the toolbar ribbon.



View Menu
View Menu Commands
The View menu provides commands used to change Password Keeper display options. These items provide a means of 
changing the Password Keeper window appearance. A short description of each item follows:

By Account
Check this item to display password account records sorted by account name. The Alt+A shortcut can be used for this 
command.

By User Name
Check this item to display password account records sorted by user name. The Alt+U shortcut can be used for this 
command.

By Password
Check this item to display password account records sorted by password. The Alt+P shortcut can be used for this 
command.

Visit URL
Use this command to automatically launch your web browser and go the currently displayed account record’s web site 
URL. The Ctrl+G shortcut can be used for this command.

Note If the current account record includes a password it will be copied to the Clipboard prior to launching your web 
browser.

Minimize
Minimizes the Password Keeper window to a button or icon on the taskbar. The Ctrl+Y shortcut can be used for this 
command.

Always on Top
Use this command to keep the Password Keeper window top most on the desktop. When this item is checked the 
Password Keeper window will float above all other non-topmost windows on the desktop. This item is useful if you normally 
run Password Keeper with a small window that would be easily obscured by other applications. The Ctrl+T shortcut can be 
used for this command.



Help Menu
Help Menu Commands
The Help menu provides commands used to get help with Password Keeper operations. A short description of each item follows:

Contents
Opens the Password Keeper Help window and displays the Table of Contents. The F1 shortcut can be used for this 
command.

Search
Opens Password Keeper Help and displays the Search window. You can use this window to search for specific Password 
Keeper help topics.

How to Use Help
Opens a Help window that explains how to use the MS Windows 95/NT Help program.

Register
Displays the Password Keeper Shareware Registration Wizard. This wizard allows you to register    Password Keeper for 
Windows 95/NT for authorized use.

Setup
Displays the Password Keeper Explorer Setup property sheet. This window provides options to integrate Password Keeper 
with the MS Windows Explorer. Use this window to create MS Explorer Start Menu items and desktop icons.

Web Site
Opens your web browser application and goes directly to the Software Design web site on the Internet.

About Password Keeper
Displays the Password Keeper splash box. This window contains program information, the current version of Password 
Keeper you are running and a program copyright notice. Click the mouse anywhere in this window to close it

Tip Commonly used Help commands can be invoked using shortcut keys or buttons on the toolbar ribbon.



Toolbar Buttons
Tool Ribbon Buttons
Most commonly used Password Keeper menu commands can also be quickly invoked by pressing a button on the toolbar ribbon
displayed at the top of the main window. These buttons work exactly the same way as the corresponding menu items that they 
duplicate.

New - Create a new document

Open - Open an existing document

Save - Save changes made to a document

Print - Print the current document

Properties - Show document properties

Copy - Copy the current password entry

Visit URL – Go to the current web site URL

Add - Add a new account record

Edit - Edit the current account record

Delete  - Delete the current account record

Options - Open the Password Keeper Options property sheet

Help - Open this Help file

About - Show Password Keeper splash box

Tip If the Show ToolBar Tips option is selected a small popup tip window will appear when the mouse pointer is placed over a 
button. A short description of what each button does can be viewed using this method.



Shortcut Keys
Shortcuts
Shortcut keys allow you to quickly invoke Password Keeper menu commands without first displaying the menu and then 
selecting an item from it. The most commonly used Password Keeper commands can be invoked using the following shortcut 
keys.

File Menu
Ctrl+N Create a new Document
Ctrl+O Open an existing document
Alt+Enter Show properties for current document
Ctrl+W Close the current document
Ctrl+S Save changes made to the document
Ctrl+P Print the current document
Ctrl+Q Exit Password Keeper, and return to the desktop

Edit Menu
Ctrl+L Copy the login password to the Clipboard
Ctrl+A Add a new password account record
Ctrl+E Edit the current account record
Del Delete the current selection

View Menu
Alt+A Sort by Account
Alt+U Sort by User Name
Alt+P Sort by Password
Ctrl+G Visit the currently selected web site URL
Ctrl+Y Minimize Password Keeper to a button or icon
Ctrl+T Make Password Keeper topmost on the desktop

Help Menu
F1 Display this Help file



Comments and Upgrades
Comments and Suggestions
If you have comments, questions or find any bugs in Password Keeper for Windows 95/NT please feel free to contact me on 
CompuServe.

Gregory Braun
CompuServe: 71613,2175
Email: 71613.2175@compuserve.com
Web Site: http://www.execpc.com/~sbd
Phone: 1.414.444.8497

Web Site
Visit my web site on the Internet to download the latest versions of all of my software offerings.

Software Design Web Site

(http://www.execpc.com/~sbd)



Release History
Password Keeper for Windows 95/NT Release History

v2.0 Original in-house development and testing of MS Windows 95/NT conversion using the Microsoft Win32 SDK.

v2.1 Added 95/NT splash box for release.

v2.2 Added options to place program icon in the taskbar notification tray, and to save desktop locations for all dialog boxes. 
Increased the encryption rotor sizes.

v2.3 Added an option to automatically save the changes made to a password document.

v2.4 Added Login Name entry field to account password records.

v2.5 Fixed several minor bugs.

v2.6 Added support for screen color settings as specified in the Display Properties dialog. Added default user and company 
name to the splash box.

v2.7 Added an option to change document access passwords. Included a new MS Windows 95/NT Help file. 

v2.8 Set window focus to default to the Account Name combobox for easier account selection. Added the Ctrl+L shortcut key 
to copy the login password field to the Clipboard.

v2.9 Replaced the PASSKEEP.INI file with MS Windows 95/NT System Registry entries.

v3.0 Added facility to optionally generate random alphanumeric account passwords automatically.

v3.1 Added Explorer Setup facilities. Increased .PWK document size from 512 to 1024 accounts. Fixed a display bug that 
prevented the “&” and “%” characters from being properly rendered.

v3.2 Added automatic Microsoft Windows 95/NT Explorer integration during setup. Fixed several minor bugs.

v3.3 Converted the Password Keeper dialog box to a four-tab property sheet. Fixed a bug that prevented proper window 
repositioning when the MS Explorer Taskbar was placed along the left edge or at the top of the desktop and the Auto 
Hide option was active. Added Page Layout settings for printed reports. Fixed several minor bugs.

v3.4 Fixed a bug that prevented the proper font size when printing Password Keeper account database reports.

v3.5 Password Keeper now behaves like a true Taskbar Tray application when the Place Icon in the Taskbar Tray option is 
selected. Added the Visit URL command to automatically go to a specified web site address. Increased the size of the 
various account record entry fields. Decreased the minimum password display period to 1 second from the previous 10 
second delay. Added the Shareware Registration Wizard. Several other minor bugs have been fixed.

v3.6 Added a Password Keeper Security Settings property sheet. Added options to minimize the Password Keeper main 
window when the password display timer elapses. Added an option to hide the password for the currently selected 
account record. Converted all account record display fields to support Clipboard Copy operations. Fixed several other 
minor bugs.

v3.7 Added an improved data encryption algorithm. Added record comments to the printed report. Fixed several minor bugs.

Last Update    April 7th, 1998



System Registry
Password Keeper for Windows 95/NT System Registry Key
Password Keeper for Windows 95/NT stores configuration settings in the MS Windows 95/NT System Registry. These settings 
are updated automatically while Password Keeper is running. There is no need to edit these settings manually.

If you insist upon editing these settings, you do so at your own risk. Password Keeper automatically updates registry entries 
when it exits. If you wish to edit these settings make sure Password Keeper is not running while you edit them. If Password 
Keeper is currently running your editing changes will be overwritten when Password Keeper exits.

Password Keeper for Windows 95/NT stores configuration settings in the following system registry key:

HKEY_CURRENT_USER
Software

Software by Design
Password Keeper for Windows 95/NT

Section
Label = Value

Warning There is no need to edit these settings manually. Password Keeper will automatically maintain these settings for you. If 
you do edit these, you do so at your own risk.



Removing Password Keeper
Removing Password Keeper for Windows 95/NT
If you find that Password Keeper for Windows 95/NT does not meet your needs you can remove it from your computer system 
by simply deleting the following files from your hard drive. All of these files will be located in the folder that you originally installed
Password Keeper in.

If you used the SETUP.EXE program and specified the default installation directory all Password Keeper files will be found in the
C:\Program Files\Software by Design folder.

PASSKEEP.EXE Password Keeper application program
PASSKEEP.CNT Password Keeper Help Topics File
PASSKEEP.HLP Password Keeper Help File

If you have opened and used the Password Keeper for Windows 95/NT Help files your system may contain the following two (2) 
files. These files are created by the standard MS Windows 95/NT Help program WinHlp32.exe. These files may also be safely 
removed.

PASSKEEP.GID MS Windows Help settings file. This file contains the Password Keeper Help window size and 
desktop location as well as any bookmarks you may have created.

PASSKEEP.FTS MS Windows Help word database. This file is created when you build a custom word list for 
Password Keeper Help files. This file is used to search for words and phrases in the Password 
Keeper Help files.

Password Keeper for Windows 95/NT does not use any custom DLL files or system drivers. If you delete the files mentioned 
above from your system’s hard drive you will have completely removed Password Keeper from your computer system.

Note If you have installed Password Keeper shortcuts on the MS Explorer Start Menu use the Help | Setup command to 
remove the shortcuts you created before you delete the Password Keeper files mentioned above.



Software Design Web Site
Software Design
You can download the latest versions of all of my software from my web site on the Internet. I post the latest releases of my 
software there first. Click your mouse on the link listed below to visit the Software Design web site.

Software Design Web Site

(http://www.execpc.com/~sbd)

Software Titles
The following software titles are available at my web site on the Internet and can also be found on CompuServe, ExecPC, MSN
and ZD Net.

NoteBook for Windows (NBOOK.ZIP)
NoteBook for Windows 95/NT (NBOOK32.ZIP)
Reminders for Windows (REMIND.ZIP)
Reminders for Windows 95/NT (REMIND32.ZIP)
ToolBar for Windows (TBAR.ZIP)
ToolBar for Windows 95/NT (TBAR32.ZIP)
Screen Loupe for Windows (LOUPE.ZIP)
Screen Loupe for Windows 95/NT (LOUPE32.ZIP)
Screen Loupe for Macintosh (LOUPE.SEA)
Audition for Windows 95/NT (AUDITION.ZIP)
Password Keeper for Windows 95/NT (PASSKEEP.ZIP)
CardBase for Windows 95/NT (CARDBASE.ZIP)
File Editor for Windows (FXEDIT.ZIP)
File Editor for Windows 95/NT (FXEDIT32.ZIP)
Crypto for Windows 95/NT (CRYPTO.ZIP)
Icon Extractor for Windows (ICONX.ZIP)
Icon Extractor for Windows 95/NT (ICONX32.ZIP)
FontShow for Windows 95/NT (FONTSHOW.ZIP)
TxEdit for Windows 95/NT (TXEDIT.ZIP)
DLL Show for Windows 95 (DLLSHOW.ZIP)
RGB Editor for Windows (RGB.ZIP)
RGB Editor for Windows 95/NT (RGB32.ZIP)
Quiz Wizard for Windows 95/NT (QUIZWIZ.ZIP)
Programmer's IDE (PMAN.ZIP)
Programmer's IDE 95/NT (PMAN32.ZIP)
Touch for Windows (WTOUCH.ZIP)
Disk CleanUp for Windows 95/NT (CLEANUP.ZIP)
BattleStar for Windows (BSTAR.ZIP)
BattleStar for Windows 95/NT (BSTAR32.ZIP)
World Radio for Macintosh (WRADIO.SEA)

Note The latest versions of my software programs are always posted on my web site first. Versions found on the other online 
services may be earlier releases.



BBS and Internet Operators
Webmasters
Please upload the original ZIP file intact and title the submission:

"Password Keeper for Windows 95/NT v3.7"
--Author Gregory Braun

Web Site
Visit my web site on the Internet to download the latest versions of all of my software offerings.

Software Design Web Site

(http://www.execpc.com/~sbd)

Note This site also supports anonymous FTP transfers.



What is Shareware
The concept of "Shareware"...
Shareware, also known as user supported software and other names, is a concept not understood by everyone. The author of 
Shareware retains all rights to the software under the copyright laws while still allowing free distribution. This gives the user the 
chance to freely obtain and try out software to see if it fits their needs. Shareware should not be confused with Public Domain 
software even though they are often obtained from the same sources.

If you continue to use Shareware after trying it out, you are expected to register your use with the author and pay a registration 
fee. What you get in return depends on the author, but may include a printed manual, free updates, telephone support, etc. Only 
by paying for the Shareware you use do you enable the Shareware author to continue to support his software and create new 
programs. Considering that the Shareware registration fees are almost always far less than the purchase price of comparable 
commercial software it's obvious that Shareware is a good deal for everyone.

There are real advantages to you in the Shareware system. You get to try out software to make sure it is compatible with your 
hardware and that it fits your needs before you "buy" it with your registration. The author saves the expense of advertising, 
packaging and distribution and passes the savings on to you. Plus, most Shareware authors are much more accessible than 
commercial software sources so that your questions and suggestions are much more likely to be responded to.

Thank you for your support.



Registering Password Keeper for Windows 95/NT

Registering Password Keeper
Password Keeper for Windows 95/NT is distributed as shareware. You may evaluate it free of charge for 30 days. After 30 days 
if you continue to use Password Keeper for Windows 95/NT you are required to register it. If after evaluating Password Keeper 
for 30 days you decide not to register it you are required to remove it from your computer.

Registration entitles you to unlimited free updates and telephone support.

You can register Password Keeper for Windows 95/NT by mailing the Order Form provided with this software. When you register
Password Keeper for Windows 95/NT you will receive your registration code by E-Mail, or optionally you may request that your 
registration code be mailed to you.

The software you are currently using is a fully functioning program. There are no time limitations built into the software to restrict 
its continued use and no program features have been disabled. As a registered user you will however be able to disable the 
initial splash box that appears when Password Keeper for Windows 95/NT is first launched.

To register your copy of Password Keeper for Windows 95/NT select the Help | Register menu command. The Shareware 
Registration Wizard will be displayed when this menu command is selected. Use this window to fill in the following entry fields:

User Name
Enter the user name you originally specified when you ordered Password Keeper for Windows 95/NT.

Organization
Enter the name of your organization as originally specified when you ordered Password Keeper for Windows 95/NT. If you did 
not specify an organization name leave this field blank.

Registration
Enter the registration code that was provided to you. Enter your registration code exactly as provided. Do not include spaces 
when entering your registration code.

Note The registration code was provided to you when you purchased Password Keeper for Windows 95/NT. Refer to the 
notification letter that was mailed to you or the E-Mail message you received for your personal shareware registration code.

Show Splash Box at Startup
This box will be initially checked if you have not registered Password Keeper for Windows 95/NT. When you successfully 
register your copy of Password Keeper this box will automatically be unchecked for you. If you wish to see the splash box 
when Password Keeper is launched return to this Registration Wizard and check this box.

OK
Press this button after you have filled out the Shareware Registration Wizard to complete Password Keeper for Windows 
95/NT shareware registration.

Cancel
Press this button to close the Shareware Registration Wizard    without making any changes.

Help
Press this button to open the Password Keeper Help window and go directly to the Registering Password Keeper topic.



Purchasing Information
Purchasing Information
Password Keeper for Windows 95/NT is distributed as shareware. You may evaluate it free of charge for 30 days. After 30 days 
if you continue to use Password Keeper for Windows 95/NT you are required to register it. If after evaluating Password Keeper 
for 30 days you decide not to purchase it you are required to remove it from your computer.

Registration entitles you to unlimited free updates and telephone support.

You can register Password Keeper for Windows 95/NT by mailing the Order Form provided with this software. When you register
Password Keeper for Windows 95/NT you will receive your registration code by E-Mail, or optionally you may request that your 
registration code be mailed to you.

The software you are currently using is a fully functioning program. There are no time limitations built into the software to restrict 
its continued use and no program features have been disabled. As a registered user you will however be able to disable the 
initial splash box that appears when Password Keeper for Windows 95/NT is first launched.

Single User Licensing
Individual users can register Password Keeper for Windows 95/NT for $20.00 dollars. If you would also like a 3 ½” floppy disk 
sent to you please add an additional $5.00 dollars. Registration entitles you to unlimited free updates and telephone support. 
You can always download the latest release of Password Keeper directly from the Software Design web site on the Internet. 
Print the Password Keeper for Windows 95/NT Order Form and mail it with your check to become a registered user of Password
Keeper for Windows 95/NT.

Site Licensing
Password Keeper for Windows 95/NT can also be registered for use at an entire site for $250.00 dollars. If you would like to 
install and use Password Keeper on multiple workstations at a single location choose this type of licensing. Registration includes
a 3 ½” floppy disk and entitles you to unlimited free updates and telephone support. You can always download the latest release
of Password Keeper directly from the Software Design web site on the Internet. Print the Password Keeper for Windows 95/NT 
Order Form and mail it with your check to become a registered user of Password Keeper for Windows 95/NT.

Corporate Licensing
Password Keeper for Windows 95/NT can also be registered for use at multiple sites for $1000.00 dollars. If you would like to 
install and use Password Keeper on multiple workstations at multiple locations choose this type of licensing. Registration 
includes a 3 ½” floppy disk and entitles you to unlimited free updates and telephone support. You can always download the 
latest release of Password Keeper directly from the Software Design web site on the Internet. Print the Password Keeper for 
Windows 95/NT Order Form and mail it with your check to become a registered user of Password Keeper for Windows 95/NT.



Password Keeper for Windows 95/NT Order Form

To print this order form, press the Print button above, or select Print Topic from the File pull-down menu.

To order by check, send this order form and a check to:

Gregory Braun
P.O. Box 1307
Milwaukee, WI    53201-1307 U.S.A.

Payments must be in US dollars drawn on a US bank, or you can send international postal orders in US dollars.

All orders are subject to the License Agreement.

Customer information is considered confidential and will not be shared or distributed to any third parties.

Registered users of Password Keeper for Windows 95/NT are entitled to unlimited free program updates.

Single User Copy ______ at $20.00 each = ________

Optional 3 ½” Disk ______ at $5.00 each = ________
Site License ______ at $250.00 each = ________

Includes 3 ½” Disk
Corporate License ______ at $1000.00 each = ________

Includes 3 ½” Disk

Wisconsin Residents add 5.5% sales tax: ________

Total Payment: ________

Date ____________________________________

Name ____________________________________

Organization ____________________________________

Shipping Address ____________________________________

____________________________________

City ____________________________________

State ____________________________________

Zip Code ____________________________________

Country ____________________________________

Day Phone ____________________________________

E-Mail Address ____________________________________
[    ] Please send registration code via E-Mail

Comments:



License Agreement
License Agreement

You should carefully read the following terms and conditions before using this software.    Unless you have a different license 
agreement signed by Gregory Braun, your use of this software indicates your acceptance of this license agreement and 
warranty.

Registered Version
One registered copy of Password Keeper for Windows 95/NT may either be used by a single person who uses the software 
personally on one or more computers, or installed on a single workstation used nonsimultaneously by multiple people, but not 
both.

Site License
Any number of users at a single location may access the registered version of Password Keeper for Windows 95/NT through 
a network, provided that you have obtained a site license for the software covering all workstations that will access the 
software through the network. Any number of users at a single location can install and use the software on one or more 
computers or workstations.

Corporate License
Any number of users at any number of locations may access the registered version of Password Keeper for Windows 95/NT 
through a network, provided that you have obtained a corporate license for the software covering all workstations that will 
access the software through the network. Any number of users at any number of locations can install and use the software on 
one or more computers or workstations.

Software Updates
Registered users of Password Keeper for Windows 95/NT are entitled to unlimited free program updates. Software updates 
can be downloaded directly from the Software Design web site on the Internet.

Governing Law
This agreement shall be governed by the laws of the State of Wisconsin.

Disclaimer of Warranty
THIS SOFTWARE AND THE ACCOMPANYING FILES ARE SOLD "AS IS" AND WITHOUT WARRANTIES AS TO 
PERFORMANCE OR MERCHANTABILITY OR ANY OTHER WARRANTIES WHETHER EXPRESSED OR IMPLIED. NO 
WARRANTY OF FITNESS FOR A PARTICULAR PURPOSE IS OFFERED.

Good data processing procedure dictates that any program be thoroughly tested with non-critical data before relying on it. The
user must assume the entire risk of using the program.    ANY LIABILITY OF THE SELLER WILL BE LIMITED EXCLUSIVELY 
TO PRODUCT REPLACEMENT OR REFUND OF PURCHASE PRICE.




